
Subject- IT          Class-IX 

Chapter-1 (Communication Skills) 

1. Fill in the blanks: 

 (1) Communication in which language is not used is said as ....................... 

 (2) The word 'Communication' comes from the Latin word.................  

(3) .................. is the movement of body, hands or head to express an idea or 

meaning.  

(4) Humans express with an important tool of communication called...................  

(5) ................... shows your confidence and feelings 

2. What do you mean by communication? Write its types. 

3. Write the process of communication. 

4. Explain any three communication barriers. 

5. Explain 7C’s of effective communication. 

6. Draw the figure of communication cycle. 

7. Write any five types of non-verbal communication. 

 

Chapter-2 (Self communication Skills) 

1. Select the most suitable alternative: 
(a)  Which of the following grooms Self-Management skills? 

(i) Self-Awareness           (ii) Self-Confidence 

(iii)  Self-Discipline            (iv) All of these 

(b)  ................. is having a clear perception of your personality. 

(i) Self-Control   (ii) Self-Awareness 

(iii) Self-Confidence    (iv) Self-Motivation 

2. What do you mean by self-management skills? 

3. What is stress? Write types of stress. 

4. What are the different practices of self management skills? 

5. Write any three self-confidence Building tips. 

6. Differentiate between Interest and abilities. 
 

Chapter-3 (Digital Documentation) 
1. (i) Which of following is not a component of the Office Suite? 

 (a) Writer    (b) Impress 

 (c) Internet Explorer  (d) Base  

             (ii)  The most widely used word processing software in late 1970s was________. 

                 (a) Word Perfect   (b) Word 

                 (c) Word Star    (d) Writer 



          (iii) We can change the mistakes noticed in which of the following? 

              (a) Electronic typewriter  (b) Word processor software 

              (c) Simple typewriter   (d) Both (a) and (b)  

          (iv)  Header and Footer is available in which of the following menus? 

                 (a) File Menu   (b) Insert Menu  

                (c) View Menu   (d) Edit Menu 

          (v) To hide or view ruler we should go to which of the following menus? 

                (a) Tools Menu   (b) Insert Menu 

                (c) View Menu   (d) Edit Menu 

2. Name three Web-based word processor. 

3. Identify the parts and Fill the boxes given below. 

 

 

 

 

 

 

 

 

 

 

 

 

4. Write any five features of word processor. 

5. What is mail merge? Write the steps to mail merge. 

6. What do you mean be document view? Write their types. 

7. What is the extension of writer file? 

8. Name any two-web based word processor. 

9. Write the difference between copy &Paste and cut & paste. 

10. What do you mean by page style? Write the various types of style in Libre Office 

Writer? 

11. What do you mean formatting text? Explain clone formatting. 

12. What is change case? Write their types. 

13. What is the difference between  H2SO4   and  A2 

14. What is paragraph indent?  

15. Write shortcut keys of the following functions. 

a) Bold   b) Italic  c) underline  d) undo e) redo 



f) cut   g) copy  h) paste  i) find  

j) Find & Replace  

 

Chapter-4 ( IT and ITes) 
1. What do you mean by ICT? Write any four basic operations of IT. 

2. What do you mean by BPO? Write any four services of BPO. 

3. What is the difference between MNCs and ISP? 

4. Which are the different areas of healthcare where IT is used? And how? 
5. What are the pros and cons of using ICT? 
6. Which software are used in digital communication? 
7. Name the Machines depicted in the images given below 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter-5 (Keyboarding Skills) 
1. By the Help of the figure given below answer the following questions: 

 



(a) Name the Home Keys (b) What are Guide Keys 

(c)  Name one Toggle Key 

2. What is a touch typist? 
3. What is the part of the keyboard is shown in the figure below? 

 
4. Differentiate between Backspace and Delete key. 
5. Explain the role of typing ergonomics. 
6. Write the use of left and right click of the mouse button. 

 

SPREADSHEET 

A. Multiple Choice Questions  

1. Which of the following technique can be used to allow only date value in cell?  

(a) Data formatting  (b) Data sorting  (c) Data filtering  (d) Data validation 

2. Which of the following options when selected deletes all data validation?  

(a) Delete formatting  (b) Delete all  (c) Delete formula  (d) Delete me 

 3. We can replace multiple occurrences of a word using which of the following facilities of Calc? 

 (a) Find and replace  (b) By replace only  (c) By copy command  (d) By preview command  

4. What is the name of mechanism to arrange the data in a particular order? 

(a) Sorting (b) Searching  (c) Filtering  (d) Validating  

5. What is the name of mechanism to filter out unnecessary data? 

 (a) Sorting  (b) Searching  (c) Filtering (d) Validating  

6. Which of the following type of package does Calc refer to?  

(a) Spreadsheet   (b) Double sheet  (c) Multi-sheet  (d) Cannot determine  

7. Which of the following is an extension of a worksheet created in Calc?  

(a) .ods   (b) .odd  (c) .xls  (d) .obj 

8. How can one calculate the total of values entered in a worksheet column of?  

(a) By manual entry  (b) By auto-sum  (c) By formula  (d) By sum function  

9. If we move a cell containing a formula having reference to another cell in the worksheet what will happen to the 

cell numbers used in the formula?  



(a) The cell row and columns are changed at destination.  

(b) The cell row change at destination. 

 (c) The cell columns are changed at destination.  

(d) No change will scour.  

10. What is the correct way to enter a function in Calc?  

(a) Directly typing function name in a cell  (b) Using function wizard or selecting from toolbar    

(c) Both (a) and (b)  (d) Depends on the function 

11. A function should start with__________________.  

(a) ‘=’ sign (b) alphabets (c) numbers (d) All of the these 

 12. Which of the following option is used to print a chart? 

 (a) Insert → Chart (b) File → View (c) File → Print (d) View → Chart  

13. How many axes does charts in Calc have? (a) Two  (b) Three  (c) Two or three  (d) Four  

14. The chart preview can be seen in________________. 

 (a) Page preview  (b) Chart preview  (c) Export chart  (d) All of these 

B. Fill in the blanks 

 1. The column immediately next to column “Z” is ___________________.  

2. The default extension of a workbook created using a LibreOffice Calc spreadsheet is _____________.  

3. The spreadsheet feature used to continue the series is called as __________________.  

4. The formula “=MIN(C1:C5)” stored in cell C6 when copied to cell D6 changes to ______________.  

5. The formula in cell A2 is =B2+C3. On copying this formula to cell C2, C2 will change to _____________.  

6. The cell address of the cell formed by the intersection of the ninth column and the eighth row will be 

_____________. 

 7. $A1$B2 is an example of _____________ referencing in spreadsheet software.  

8. Numbers entered into a cell are automatically ___________ aligned.  

9. If A1:A5 contain the numbers 16, 10, 3, 25 and 6 then =Average(A1:A5;60) will display______________.  

10. In _______________referencing, the reference changes rows and columns automatically when it is copied to a 

new cell. 

C. Solve the following in a spreadsheet  

1. Cell A1 contains the number 10 and B1 contains 5. What will be the contents of cell C1, if the formula =A1+B1*2^3 

is entered in cell C1? 

 2. The contents of Cell A1, B1, C1 and D1 are 5, –25, 30 and –35, respectively. What will be the value displayed in cell 

E1 which contains the formula =MIN(A1:D1).  

3. Cell D5 contains the formula =$B$5+C5 and this formula is copied to cell E5, what will be the copied formula in cell 

E5? 



 4. Cell D5 contains the formula =$B5 + C5 and this formula is copied to cell E5, what will be the copied formula in cell 

E5?  

5. Cell D5 contains the formula =$B5 + C$5 and this formula is copied to cell E6, what will be the copied formula in 

cell E6 

D. Short answer questions (50 words)  

1. What do you call the document created in a spreadsheet application?  

2. What are the steps to create a new spreadsheet?  

3. What is the difference between spreadsheet, worksheet and sheet?  

4. What is the default name of the worksheet? How can it be renamed?  

5. Write the steps to insert and delete the worksheet in Calc. 

 6. What is an active cell? How to delete the contents of an active cell?  

7. What is relative and absolute cell address in the spreadsheet?  

8. Explain any two operations performed on data in a spreadsheet. 

 9. How do formulae work in a spreadsheet? 

 10. Can you include more than one mathematical operators in a formula? 

11. How to make visible the desired toolbar a spreadsheet?  

12. Give the syntax and example of any three mathematical functions in spreadsheet.  

13. Give the syntax and example of any three statistical functions in spreadsheet.  

14. Give the syntax and example of any three decision making functions in spreadsheet.  

15. Give the syntax and example of any three date and time functions in spreadsheet.  

16. Give the syntax and example of any three logical functions in spreadsheet.  

17. Give the syntax and example of any three string functions in spreadsheet. 

 18. Explain the advantages of drawing a chart in Calc.  

19. Explain in one line each the various types of charts.  

20. Write the steps to insert a chart in Calc.  

21. Name and explain any five components of a chart in a spreadsheet package. 

 

DIGITAL SPREADSHEET 

A. Multiple Choice Questions  

1. Which of the following option is not available on Presentation Wizard? 

 (a) Empty presentation   (b) Form template  (c) Open new presentation (d) Open existing presentation 

 2. Which of the following is not a part of main Impress window?  

(a) Slides pane  (b) Workspace   (c) Work pane  (d) Task pane  

3. Which of the following is not a section of tasks pane?  



(a) Master pages  (b) Layouts  (c) Custom View  (d) Custom animation  

4. Which view button listed below is not one of those available in the workspace?  

(a) Normal view   (b) Outline view  (c) Thumbnail view  (d) Notes  

5. Which view is generally used for creating, formatting and designing slides?  

(a) Normal view  (b) Outline view  (c) Notes (d) Slide Sorter view 

 6. The slide show can be exited at any time during the show by pressing which of the following keys? 

 (a) Space bar  (b) End key  (c) Break key (d) Esc key 

7. Which of the following features is used to create a new slide show with the current slides but presented in a 

different order?  

(a) Rehearsal  (b) Custom Slide show  (c) Slide Show Setup  (d) Slide Show View  

8. Which of the following feature is used to progress the slide show automatically while speaking on the topic?  

(a) Custom Animation  (b) Rehearse Timing  (c) Slide Transition  (d) Either (a) or (b) 

B. Fill in the blanks 

 1. ___________________ is used to maintain consistency in design and colour in the presentation.  

2. ________________view is used to view all the slides simultaneously.  

3. ________________is used to perform basic operations on the presentation  

4. Master Page is used to modify the _____________of the slide. 

 5. To create a new blank presentation, use the key combination ____________.  

6. In every presentation, first slide should be ___________________. 

7. To save a presentation, we can use key combination _______________ .  

8. In LibreOffice Impress, by default the presentation is saved with _________extension.  

9. The keyboard shortcut key for slide show is _____________.  

10. The short cut key to close the LibreOffice impress is _______________.  

11. The short cut key to insert a new slide is ________________. 

 12. The ____________ view is used to apply animation on the content of slide  

13. A paper copy of presentation given to the audience is known as ________________.  

14. To play a sound during transitions, select a sound from the ______________ list.  

15. To play the sound repeatedly, the __________________is used. 

C. Short answer questions (50 words) 

 1. List the possible multimedia contents that are included while creating a presentation. 

 2. List the important points to be considered while making an effective presentation. 

 3. What are the advantages of using a presentation?  

4. What objects can be inserted to slides in Impress? 

5. What are the steps to add picture or object to the slide? 



 6. How can text be added to header or footer on the sliders? 

 7. Describe the use of fields available in header and footer 

8. Write the steps to create a template. 

 9. Write down the steps to add slide transition in your presentation. 

 10. How will you add the slide number at the bottom of each slide?  

11. How will you insert a company’s logo (picture) in first slide of your presentation?  

12. How will you add the name of the company on the top of the each slide?  

13. Write down the steps to create a table in a presentation.  

14. Write down the steps to insert a chart in slide. 

15. What are the five views of presentation? 


